
Replication Package for: Safety First: Perceived Risk of Street Harassment and
Educational Choices of Women

This paper examines the long-term consequences of unsafe public spaces for women. It combines student-level survey data, a mapping of potential travel
routes to all the colleges in the choice set, and crowdsourced mobile application safety data from Delhi. The findings show that women choose a college in the
bottom half of the quality distribution over a college in the top quintile to feel safer while traveling, relative to men with comparable choice sets who choose a
college in the top one-third of the distribution over a college in the top quintile. These findings have implications beyond women’s human capital attainment,
such as their participation in the labor force.

Overview
The code in this replication package create the figures and tables in the paper using Stata and Matlab. Three main files run all of the code to generate the data
for the outputs.

Data Availability

Summary of Availability

All data are publicly available.
Some data cannot be made publicly available.
No data can be made publicly available.

Details on each Data Source

The main data sources are:

1. A 3,800 student-level survey conducted at The University of Delhi (DU) in 2016.
2. A mapping of potential travel routes to all colleges in the choice set, build up with Google Maps and an algorith developed by the author.
3. Safety data from two crowdsourced mobile applications in Delhi, which allowed to assign a safety score to each travel route:

SafetiPin, which provides perceived spatial safety data in the form of safety audits conducted at various locations across the Delhi National Capital
Region (NCR).
Safecity, which provides analytical data on harassment rates by travel mode recorded by users during their travel in the city.

Dataset list

Available on Microdata Library as Licensed files. Link

Data file Source Notes Provided

data/raw/*collegecode*_data.xlsx*
Collected
by author

Student-level survey data. Yes

data/raw/alphaid.dta
Created by
author

This file contains alpha identifiers. Yes

data/raw/car_price.xlsx*
carwale
website

Data collected on June 25,2017. These data are no longer available
because the prices have been updated to today's rates.

Yes

data/raw/coll_withsafety.dta
Created by
author

College details. Yes

data/raw/college_descriptives.dta
Created by
author

Yes

data/raw/college_fees.dta
Creted by
author

This file contains the fees for each college and course. The original links to
the information are no longer available, but the data were accessed in
2016. The process involved visiting each college’s website and using the
fee data published in the universities’ fee structure reports.

Yes

data/raw/College_locations.dta
Created by
author

The dataset includes information from the College_coordinate.dta and
student_pop_bygender.csv databases, supplemented with additional
details about whether the college participated in the full or short survey
conducted by the author, as well as whether the college is exclusively for
women or coeducational.

Yes

data/raw/comparing_samples_updated.dta
Collected
by author

Clean database to create table A1. Yes

data/raw/men_grid_popdensity.csv* Meta Author used population_ind_pak_men.zip. Find more instructions below. Yes
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Data file Source Notes Provided

data/raw/placement_data_tally_placed.dta
Collected
by authors

Yes

data/raw/randcoor_route_saf_bycollege.dta
Created by
authors

Yes

data/raw/RankofColl_col.xlsx*
Created by
authors

Yes

data/raw/SS_data.dta
Collected
by author

Short-survey. Yes

data/raw/SS_online.xlsx*
Collected
by author

Short-survey. Yes

data/raw/stud_coll_catchment.dta
Created by
author

Yes

data/raw/Survey of College
Choice_v3003.csv*

Collected
by author

Yes

data/raw/women_grid_popdensity.csv* Meta
Author used population_ind_pak_women.zip. Find more instructions
below.

Yes

Notes

(*) The datasets available on the Microdata Library are provided in both XLSX/CSV and DTA formats; however, to run the code, the XLSX/CSV files should be
used.

Women and Men population data

To process population density data for Delhi, start with the male and female population density rasters from the Meta dataset, specifically, download
population_ind_pak_men.zip and population_ind_pak_women.zip, and inside these files locate population_20_lon_70_men.tif and population_20_lon_70_women-
v1.5.tif. Open ArcMap and add both rasters together with the Delhi boundary shapefile NCR_boundary_Project.shp. Because the original rasters contain decimal
values, multiply each raster by 1000 and convert the results to integers before polygon conversion. To do this, open ArcToolbox → Spatial Analyst Tools → Map
Algebra → Raster Calculator and run the expressions Int("population_20_lon_70_men.tif" * 1000) and Int("population_20_lon_70_women-v1.5.tif" * 1000), saving
the outputs as men_popdensity_int.tif and women_popdensity_int.tif, respectively. Next, convert both integer rasters into polygons using ArcToolbox →
Conversion Tools → From Raster → Raster to Polygon, selecting the VALUE field and leaving “Simplify polygons” unchecked. Save the outputs as
men_popdensity_polygon.shp and women_popdensity_polygon.shp. Clip these polygon layers to the Delhi boundary using ArcToolbox → Analysis Tools →
Extract → Clip with NCR_boundary_Project.shp as the clipping feature, producing delhi_men_popdensity.shp and delhi_women_popdensity.shp. Open the
attribute tables of these shapefiles and add a new field called gc_conv with type Double. Using Field Calculator, calculate gc_conv = [GRIDCODE] / 1000 in order
to restore the original population density values.

To construct the analysis grid, open ArcToolbox → Cartography Tools → Data Driven Pages → Grid Index Features and use NCR_boundary_Project.shp as the
input feature. Define the grid using 10 rows and 10 columns and save the output as gridfeature_1.shp. Clip this grid again with the Delhi boundary shapefile
using ArcToolbox → Analysis Tools → Extract → Clip to create delhi_withgrid.shp. Open the attribute table of delhi_withgrid.shp and add two new Double fields
named centroid_x and centroid_y. Use the “Calculate Geometry” option to compute the X Coordinate of Centroid for centroid_x and the Y Coordinate of
Centroid for centroid_y. These centroid coordinates serve as reference points for the spatial analysis. Next, intersect the clipped population density polygon
layers with the grid using ArcToolbox → Analysis Tools → Overlay → Intersect. Intersect delhi_men_popdensity.shp with gridfeature_1.shp to create
men_grid_popdensity.shp, and intersect delhi_women_popdensity.shp with gridfeature_1.shp to create women_grid_popdensity.shp. To calculate average
population density within each grid cell, perform a Spatial Join using the grid as the target feature and the intersected population density layer as the join
feature, specifying the aggregation rule for gc_conv as Mean. Finally, export the resulting attribute tables to CSV format using the table export option,
producing men_grid_popdensity.csv and women_grid_popdensity.csv for subsequent statistical analysis.

Available on DDH as public files. Link

Data file Source Provided

data/raw/student_neighbors_forrf_1 Created by author Yes

data/raw/student_neighbors_forrf_1_5 Created by author Yes

data/raw/student_neighbors_forrf_2 Created by author Yes

data/raw/student_neighbors_forrf_2_5 Created by author Yes

data/raw/routes/all_app_arrival_rate Created by author Yes

data/raw/routes/all_app_excl_feeling Created by author Yes

data/raw/routes/all_app_excl_transport Created by author Yes

data/raw/routes/all_app_gender_usa Created by author Yes
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Data file Source Provided

data/raw/routes/all_app_grid_500 Created by author Yes

data/raw/routes/all_app_grid_1500 Created by author Yes

data/raw/routes/all_app_light Created by author Yes

data/raw/routes/all_app_open Created by author Yes

data/raw/routes/all_app_path Created by author Yes

data/raw/routes/all_app_security Created by author Yes

data/raw/routes/all_app_visibility Created by author Yes

data/raw/routes/nondelhires_app Created by author Yes

data/raw/routes/mc_simulation_app Created by author Yes

data/raw/routes/overlap_driving Created by author Yes

data/raw/routes/overlap_transit Created by author Yes

data/raw/routes/overlap_walking Created by author Yes

data/raw/routes/route_time_correction_byhand Created by author Yes

data/raw/routes/routes_additional_major Created by author Yes

data/raw/routes/routes_delhi Created by author Yes

data/raw/routes/SS_app Collected by author Yes

data/raw/Safetipin/ArcGIS/c12.shp Created by author Yes

data/raw/Safetipin/ArcGIS/c14.shp Created by author Yes

data/raw/Safetipin/ArcGIS/c18.shp Created by author Yes

data/raw/Safetipin/ArcGIS/c39.shp Created by author Yes

data/raw/Safetipin/ArcGIS/c52.shp Created by author Yes

data/raw/Safetipin/ArcGIS/c60.shp Created by author Yes

data/raw/Safetipin/ArcGIS/c62.shp Created by author Yes

data/raw/Safetipin/ArcGIS/c63.shp Created by author Yes

data/raw/Safetipin/bootstrap_datasets/appended_bbs Created by the author Yes

data/raw/Safetipin/Safety data/clip_grid_500.shp Created by author Yes

data/raw/Safetipin/Safety data/clip_grid_1500.shp Created by author Yes

data/raw/Safetipin/MAPDATA/idw_polymer_clippedtoNCR.shp Created by author Yes

data/raw/Safetipin/MAPDATA/52_013.shp Created by author Yes

data/raw/Safetipin/MAPDATA/college.shp Created by author Yes

data/raw/Safetipin/MAPDATA/student.shp Created by author Yes

Additional files

Data file Source Notes Provided

data/raw/audit_withdist.dta SafetiPin Safety audit data with associated postal district
across Delhi. The dataset includes 26,560 audits
conducted between November 2013 and January
2016. Each audit evaluates nine parameters that prior
research has identified as relevant for perceptions of
safety: lighting, openness, visibility, crowd, security,
walk path, availability of public transport, gender
usage, and feeling. Each parameter is scored on a
scale from 0 (low safety) to 3 (high safety). The
dataset includes the original audit scores, geographic
coordinates for each audited location, and a
composite safety measure (PCA_SAF) constructed
using principal component analysis (PCA) on the nine
safety parameters. The main variables used in the

No
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Data file Source Notes Provided

project analysis are PCA_SAFRES (a rescaled version
of PCA_SAF ranging from 0 to 3) and the
corresponding district name. SafetiPin data was
requested in October 2015 and received in April
2016. The data was requested in person during a
meeting since the firm was fairly new. At present, the
data needs to be requested by emailing Rithvika
Rajiv at Safetipin (Email: rithvika.rajiv@safetipin.com),
along with a formal request for data. Following the
request a Data user agreement is signed by the
requestor and then data is shared. Additional
information can be found in the Safetipin Terms and
Conditions.

data/raw/College_coordinates.dta
Google
Maps

Search for the college names in Google Maps,
extract their latitude and longitude coordinates.
Store the coordinates in the A1_co_name column,
while the A1_co column should contain the
corresponding college code. The colleges included in
this database correspond to college codes ranging
from 1 to 77. Please refer to the Survey Data
Codebook file in the MDL repository for this project
to identify the full names of the colleges. The
database is not included due to the Terms and
Conditions of Google Maps.

No

data/raw/college_enrollment.dta

University
of Delhi
Annual
Report
2015–16

Table in page 84, Under-Graduate columns. The file
is not included due to the Term and Conditions of
the University of Delhi platforms.

No

data/raw/ranking_india_today.xlsx

India
Today
annual
rankings
(2013
-2015)

In the Excel file, create the columns RANK,
COLLEGECODE, YEAR, and STREAM. Using the
websites, look up each college included in the
sample according to the College codes sheet in the
Survey Data Codebook file included in the MDL
repository. For the RANK column, record the rank
reported on the website. For COLLEGECODE, use the
code corresponding to the college according to the
codebook. For YEAR, record the year of the ranking,
and for STREAM, record the academic field or
discipline indicated on the website. These files are
not included due to the Term and Conditions of India
Today website.

No

data/raw/ranking_the_week.xlsx

The Week
annual
rankings
(2013
-2015)

The links to the data are no longer available.
However, at this link you can find an example of how
The Week publishes its annual rankings: THE WEEK-
Hansa Research Survey 2025: India’s best colleges.
The file was created by first setting up an Excel
spreadsheet and adding the columns RANK,
COLLEGECODE, YEAR, and STREAM. Information for
each college in the sample was then collected using
the corresponding websites. The RANK variable
records the rank reported on the website,
COLLEGECODE corresponds to the code assigned in
the codebook to the college, YEAR indicates the year
of the ranking, and STREAM identifies the academic
field or discipline reported on the website. These files
are not included due to the Term and Conditions of
The Week website.

No

data/raw/SafetiPin_NCR_audits.dta Safetipin Scores by the nine safety parameters along with the
time of submission and location, limited to the NCR
of Delhi. The dataset includes 26,560 audits
conducted between November 2013 and January

No

README (1).md 2026-05-20

4 / 18

https://safetipin.com/site/termsConditions/
https://safetipin.com/site/termsConditions/
https://www.google.com/help/terms_maps/
https://www.google.com/help/terms_maps/
https://www.du.ac.in/uploads/annual-reports/25102017_93_Part_2.pdf.pdf
https://www.du.ac.in/uploads/annual-reports/25102017_93_Part_2.pdf.pdf
https://www.du.ac.in/uploads/annual-reports/25102017_93_Part_2.pdf.pdf
https://www.du.ac.in/uploads/annual-reports/25102017_93_Part_2.pdf.pdf
https://www.du.ac.in/uploads/annual-reports/25102017_93_Part_2.pdf.pdf
https://www.duac.duf.du.ac.in/terms
https://specials.indiatoday.com/common/termsandconditions.phtml
https://www.theweek.in/theweek/cover/2025/06/21/the-week-hansa-research-survey-2025-india-best-colleges.html
https://www.theweek.in/theweek/cover/2025/06/21/the-week-hansa-research-survey-2025-india-best-colleges.html
https://www.theweek.in/terms-and-conditions.html


Data file Source Notes Provided

2016. Each audit evaluates nine parameters that prior
research has identified as relevant for perceptions of
safety: lighting, openness, visibility, crowd, security,
walk path, availability of public transport, gender
usage, and feeling. Each parameter is scored on a
scale from 0 (low safety) to 3 (high safety). Those
nine parameters are the key variables for the
analysis. SafetiPin data was requested in October
2015 and received in April 2016. The data was
requested in person during a meeting since the firm
was fairly new. At present, the data needs to be
requested by emailing Rithvika Rajiv at Safetipin
(Email: rithvika.rajiv@safetipin.com), along with a
formal request for data. Following the request a Data
user agreement is signed by the requestor and then
data is shared. Additional information can be found
in the Safetipin Terms and Conditions.

data/raw/du_course_enrollment.dta

University
of Delhi
Annual
Report
2013–14

Create a .dta file in which the first three variables are
course_name, course_code, and univ_category, using
the information from the Survey Data Codebook file
included in the MDL repository. Then, add three
additional variables named m, f, and t, which should
contain the information from the University of Delhi
report. For each course, locate the corresponding
entry in the report and use the values from the Total
row for the columns Total M, Total F, and Total T. If a
course has multiple total rows, use the one labeled
Regular, Day + Eve, or Grand Total, as applicable. The
file is not included due to the Term and Conditions
of the University of Delhi platforms.

No

data/raw/NCRB_rape_2013.xlsx

NCRB
Crime
Against
Women,
NCRB
Crime in
India,
Census of
India

Find below the instructions to set up this file. The file
is not included due to the Copyright statement of
the NCRB website.

No

data/raw/cutoffs/
University
of Delhi

Cut-off lists for Arts & Commerce , and Science
bachelor from 2013 to 2015. You can find the links to
the sources below. These files are not included due
to the Term and Conditions of the University of Delhi
platforms.

No

data/raw/Safetipin/Safety data/Audits_formap_2017-04-09.shp Safetipin The shapefile contains geocoded safety audit data
collected by SafetiPin across Delhi. The dataset
includes 26,560 audits conducted between
November 2013 and January 2016. Each audit
evaluates nine parameters that prior research has
identified as relevant for perceptions of safety:
lighting, openness, visibility, crowd, security, walk
path, availability of public transport, gender usage,
and feeling. Each parameter is scored on a scale from
0 (low safety) to 3 (high safety). The dataset includes
the original audit scores, geographic coordinates for
each audited location, and a composite safety
measure (PCA_SAF) constructed using principal
component analysis (PCA) on the nine safety
parameters. This composite index is the measure
used in the figure presented in the project. SafetiPin
data was requested in October 2015 and received in
April 2016. The data was requested in person during
a meeting since the firm was fairly new. At present,

No
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Data file Source Notes Provided

the data needs to be requested by emailing Rithvika
Rajiv at Safetipin (Email: rithvika.rajiv@safetipin.com),
along with a formal request for data. Following the
request a Data user agreement is signed by the
requestor and then data is shared. Additional
information can be found in the Safetipin Terms and
Conditions.

data/raw/start.xlsx

Empty
excel file
used to
organize
data

Create an empty Excel file and named it start. No

data/raw/student_pop_bygender.csv

University
of Delhi
Annual
Report
2013–14

Use table in page 444. The file is not included due to
the Term and Conditions of the University of Delhi
platforms.

No

data/raw/Safetipin/ArcGIS/CollegeLocations_final_1.shp

Google
Maps and
University
of Delhi
Annual
Report
2013–14

Location for all colleges in Delhi University and their
size. The colleges’ locations were geocoded using
Google Maps, and their size was obtained from the
report (page S-1, column ‘Total Undergraduate
Students’). The colleges included in this shapefile
correspond to the following codes: 1, 2, 3, 4, 6, 7, 8,
9. 11, 12, 13, 14, 17, 18, 19, 20, 21, 22, 24, 26, 27, 28,
29, 30, 31, 34, 35, 36, 38, 39, 41, 42, 43, 46, 47, 48, 50,
51, 52, 53, 54, 56, 57, 58, 59, 60, 61, 62, 63, 64, 65, 66,
67, 68, 69, 70, 71, 72, 75, 76 and 77. Please refer to
the Survey Data Codebook file in the MDL repository
for this project to identify the full names of the
colleges. The shapefile is not included due to the
Term and Conditions of the University of Delhi
platforms and the Terms and Conditions of Google
Maps.

No

data/raw/Safetipin/ArcGIS/coll_loc_insample_Withsize.shp

Google
Maps and
University
of Delhi
Annual
Report
2013–14

Location of the eight colleges in the sample and their
size. The colleges’ locations were geocoded using
Google Maps, and their size was obtained from the
report (page S-1, column ‘Total Undergraduate
Students’). The colleges included in this shapefile
correspond to the following codes: 12, 14, 18, 39, 52,
60, 62 and 63. Please refer to the Survey Data
Codebook file in the MDL repository for this project
to identify the full names of the colleges. The
shapefile is not included due to the Term and
Conditions of the University of Delhi platforms and
the Terms and Conditions of Google Maps.

No

data/raw/Safetipin/ArcGIS/coll_loc_shortsurvey_withsize.shp

Google
Maps and
University
of Delhi
Annual
Report
2013–14

Location of the colleges in the short survey and their
size. The colleges’ locations were geocoded using
Google Maps, and their size was obtained from the
report (page S-1, column ‘Total Undergraduate
Students’). The colleges included in this shapefile
correspond to the following codes: 4, 11, 13, 20, 21,
22, 24, 26, 27, 28, 29, 31, 34, 35, 38, 41, 42, 46, 47, 48,
50, 53, 56, 61, 64, 67, 69, 70, 71, 75, and 76. Please
refer to the Survey Data Codebook file in the MDL
repository for this project to identify the full names
of the colleges. The shapefile is not included due to
the Term and Conditions of the University of Delhi
platforms and the Terms and Conditions of Google
Maps.

No

data/raw/Safetipin/ArcGIS/NCR_boundary_Project.shp ML
Infomap

This boundaries shapefile for NCR was purchased
from ML Infomap in April 2026. At present, the data
needs to be requested using their Contact page:

No
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Data file Source Notes Provided

https://www.mlinfomap.com/contact.php and
request the boundary file for Delhi NCR.

data/raw/Safetipin/ArcGIS/NCR_PINCODE_Project.shp
ML
Infomap

This pincode boundaries shapefile for NCR was
purchased from ML Infomap in April 2026. At
present, the data needs to be requested using their
Contact page:
https://www.mlinfomap.com/contact.php and
request the boundary file for Delhi NCR postal
pincodes.

No

data/raw/Safetipin/ArcGIS/Delhi_NCT_pincodes.shp
ML
Infomap

This pincode boundaries shapefile for NCR of Delhi
was purchased from ML Infomap in April 2026. At
present, the data needs to be requested using their
Contact page:
https://www.mlinfomap.com/contact.php and
request the boundary file for Delhi NCT postal
pincodes.

No

Notes

The geocoding process using Google Maps was conducted manually. Each location was individually searched in Google Maps, and the corresponding
geographic coordinates were obtained by right-clicking on the selected location within the platform interface. These coordinates were then recorded and
incorporated into the dataset.

Instructions to set up Excel file: NCRB_rape_2013.xlsx

1. Create a new Excel workbook with two sheets: Sheet1 and dist_population.
2. To complete the dist_population sheet, follow these steps: a. Open the file census_2011.xls included in the MDL repository. b. Copy the following

columns: Area, Age-group and the three Total columns: Persons, Males and Females. c. Paste the copied information into the dist_population sheet.
3. To complete the Sheet1 sheet, follow these steps: a. Open the NCRB Crime Against Women report. b. Go to page 539 and copy the following columns:

District, Rape, Kidnapping & Abduction, Assault on Women with intent to outrage her modesty, Insult to modesty of Women, and paste this information
into Sheet1. c. Open the NCRB Crime in India report. d. Go to pages 49–51 and copy the information for the Delhi UT districts (the same districts copied
in step b) for the following columns: Dacoity, Robbery, Burglary and Theft-Total. e. Paste this information into Sheet1, next to the data pasted in step b. f.
Create the following new columns in Sheet1: male_pop_15_34, pop_15_34, male_pop_15_49, pop_15_49. Complete these columns for the following
districts: Central, East, New, Noth, North east, North west, South, South east, South west and west. Use the information from the dist_population sheet as
follows: i. male_pop_15_34: for each district, calculate the sum of the Males population for ages 15–34. ii. pop_15_34: for each district, calculate the sum
of the Female population for ages 15–34. iii. male_pop_15_49: for each district, calculate the sum of the Males population for ages 15–49. iv. pop_15_49:
for each district, calculate the sum of the Female population for ages 15–49.

4. Save the completed workbook as NCRB_rape_2013.xlsx.

Data citation

Data.Name Citation

“Cars prices” carwale (2017)

“Census of India” Office of the Registrar General & Census Commissioner (2011)

“Cut-off list Arts & Commerce First” University of Delhi (2013)

“Cut-off list Arts & Commerce Second” University of Delhi (2013a)

“Cut-off list Arts & Commerce Third” University of Delhi (2013b)

“Cut-off list Arts & Commerce Fourth” University of Delhi (2013c)

“Cut-off list Arts & Commerce Fifth” University of Delhi (2013d)

“Cut-off list Arts & Commerce Sixth” University of Delhi (2013e)

“Cut-off list Arts & Commerce Seventh” University of Delhi (2013f)

“Cut-off list Arts & Commerce Eighth” University of Delhi (2013g)

“Cut-off list Arts & Commerce Ninth” University of Delhi (2013h)

“Cut-off list Arts & Commerce Tenth” University of Delhi (2013i)

“Cut-off list Arts & Commerce First” University of Delhi (2014a)

“Cut-off list Arts & Commerce Second” University of Delhi (2014b)

“Cut-off list Arts & Commerce Third” University of Delhi (2014c)
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Data.Name Citation

“Cut-off list Arts & Commerce Fourth” University of Delhi (2014d)

“Cut-off list Arts & Commerce Fifth” University of Delhi (2014e)

“Cut-off list Arts & Commerce Sixth” University of Delhi (2014f)

“Cut-off list Arts & Commerce Seventh” University of Delhi (2014g)

“Cut-off list Arts & Commerce Eighth” University of Delhi (2014h)

“Cut-off list Arts & Commerce Ninth” University of Delhi (2014i)

“Cut-off list Arts & Commerce Tenth” University of Delhi (2014j)

“Cut-off list Arts & Commerce First” University of Delhi (2015)

“Cut-off list Arts & Commerce Second” University of Delhi (2015a)

“Cut-off list Arts & Commerce Third” University of Delhi (2015b)

“Cut-off list Arts & Commerce Fourth” University of Delhi (2015c)

“Cut-off list Arts & Commerce Fifth” University of Delhi (2015d)

“Cut-off list Arts & Commerce Sixth” University of Delhi (2015e)

“Cut-off list Arts & Commerce Seventh” University of Delhi (2015f)

“Cut-off list Arts & Commerce Eighth” University of Delhi (2015g)

“Cut-off list Arts & Commerce Ninth” University of Delhi (2015h)

“Cut-off list Arts & Commerce Tenth” University of Delhi (2015i)

“Cut-off list Arts & Commerce Eleventh” University of Delhi (2015j)

“Cut-off list Arts & Commerce Twelfth” University of Delhi (2015k)

“Cut-off list Science First” University of Delhi (2013j)

“Cut-off list Science Second” University of Delhi (2013k)

“Cut-off list Science Third” University of Delhi (2013l)

“Cut-off list Science Fourth” University of Delhi (2013m)

“Cut-off list Science Fifth” University of Delhi (2013n)

“Cut-off list Science Sixth” University of Delhi (2013o)

“Cut-off list Science Seventh” University of Delhi (2013p)

“Cut-off list Science Eighth” University of Delhi (2013q)

“Cut-off list Science Ninth” University of Delhi (2013r)

“Cut-off list Science Tenth” University of Delhi (2013s)

“Cut-off list Science First” University of Delhi (2014k)

“Cut-off list Science Second” University of Delhi (2014l)

“Cut-off list Science Third” University of Delhi (2014m)

“Cut-off list Science Fourth” University of Delhi (2014n)

“Cut-off list Science Fifth” University of Delhi (2014o)

“Cut-off list Science Sixth” University of Delhi (2014p)

“Cut-off list Science Seventh” University of Delhi (2014q)

“Cut-off list Science Eighth” University of Delhi (2014r)

“Cut-off list Science Ninth” University of Delhi (2014s)

“Cut-off list Science Tenth” University of Delhi (2014t)

“Cut-off list Science First” University of Delhi (2015l)

“Cut-off list Science Second” University of Delhi (2015m)

“Cut-off list Science Third” University of Delhi (2015n)

“Cut-off list Science Fourth” University of Delhi (2015o)
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Data.Name Citation

“Cut-off list Science Fifth” University of Delhi (2015p)

“Cut-off list Science Sixth” University of Delhi (2015q)

“Cut-off list Science Seventh” University of Delhi (2015r)

“Cut-off list Science Eighth” University of Delhi (2015s)

“Cut-off list Science Ninth” University of Delhi (2015t)

“Cut-off list Science Tenth” University of Delhi (2015u)

“Cut-off list Science Eleventh” University of Delhi (2015v)

“Cut-off list Science Twelfth” University of Delhi (2015w)

“India Today Annual Ranking 2013” India Today (2013)

“India Today Annual Ranking 2014” India Today (2014)

“India Today Annual Ranking 2015” India Today (2015)

“NCRB Crime Against Women” National Crime Records Bureau (2013a)

“NCRB Crime in India” National Crime Records Bureau (2013b)

“Pakistan & India: High Resolution Population Density Maps” Facebook and Columbia University - CIESIN (2016)

"Safecity" Asok (2016)

"The Week annual rankings 2013" The Week

"The Week annual rankings 2014" The Week

"The Week annual rankings 2015" The Week

“University of Delhi Annual Report 2013-14” University of Delhi (2014)

“University of Delhi Annual Report 2015-16” University of Delhi (2016)

Statement about Rights

I certify that the author of the manuscript have legitimate access to and permission to use the data used in this manuscript.

Instructions for Replicators
It is possible to reproduce all the analysis using only the codes available in GitHub.

1. Download the \safety-first .zip folder from from World Bank Reproducibility Research Repository and unzip it.
2. Inside the \safety-first folder, create a new folder called "output". Inside this new "output" folder, create two new folders with the names "figures"

and "tables."
3. Following the Dataset list notes download the \data and save it inside the \safety-first folder. This way, the \safety-first folder must contain the

folders \code, \output and \data, the 3 master code files and the README.md.
4. Inside de \data folder create two new folders with the names "coded" and "mixed_logit [dataset]." Inside the new "coded" folder, create a new folder

called "routes."
5. In the master code files, update the directory paths to the path on your computer that leads to the \safety-first folder.
6. Run the master code files in the following order: master_1.do, master_2.m and master_3.do.

Eveything should run smoohtly. If any inconvenience is encountered, please don't hesitate on reaching out to the authors.

Details

Figures 4, 5, 6, A1 and A14 can be reproduced using the data provided in the folder “data/raw/”, and ArcGIS Desktop (Version 10.8.2) by following these
(manual) instructions:
Figure 4:

Create a new map document in ArcGIS ArcMap, browse to the folder “data/raw/Safetipin/ArcGIS” in the “Catalog”, with files
"coll_loc_insample_Withsize.shp", "NCR_PINCODE_Project" "c12.shp", "c14.shp", "c18.shp", "c39.shp", "c52.shp", "c60.shp", "c62.shp" and "c63.shp".
Drop the files listed above onto the new map, creating ten separate layers. Then arrange them from top to bottom in the following order:
coll_loc_insample_Withsize, c52, c14, c18, c60, c12, c62, c39, and c63.
Double-click the c12 and c39 layer symbols and change them to red circles.
For the c14, c18, c52, c60, c62, and c63 layers, right-click each layer and select Properties, then go to the Symbology tab, expand Categories, and
choose Unique values. In the Value field, select data_d_fem and click Add All Values. For category 1, double-click the symbol and set it to red
circles; for category 0, double-click the symbol and set it to blue triangles; and for category NULL, uncheck it so it is not displayed.
Finally, change the coll_loc_insample_Withsize icon to black stars.

Figure 5a:
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Create a new map document in ArcGIS ArcMap, browse to the folder “data/raw/Safetipin/Safety data” in the “Catalog”, with file
"Audits_formap_2017-04-09.shp" and “data/raw/Safetipin/ArcGIS” with file "NCR_PINCODE_Project".
Drop the files listed above onto the new map, creating two separate layers. Order them with "Audits_formap_2017-04-09" in the top layer and
"NCR_PINCODE_Project" in the bottom layer.
Right-click on the layer on the Audits_formap_2017-04-09 icon and select Properties. Then, go to the Symbology tab. Expand the Quantities option
and select Graduated Colors. In the Fields section, set the Value field to PCA_SAF, select 5 classes in Natural Breaks, choose Red-Yellow-Green ramp
color and click OK.

Figure 5b:
Create a new map document in ArcGIS ArcMap, browse to the folder “data/raw/Safetipin/MAPDATA” in the “Catalog”, with file
"idw_polymer_clippedtoNCR.shp" and “data/raw/Safetipin/ArcGIS” with file "NCR_PINCODE_Project".
Drop the files listed above onto the new map, creating two separate layers. Order them with "idw_polymer_clippedtoNCR" in the top layer and
"NCR_PINCODE_Project" in the bottom layer.
Right-click on the layer on the idw_polymer_clippedtoNCR icon and select Properties. Then, go to the Symbology tab. Expand the Quantities
option and select Graduated Colors. In the Fields section, set the Value field to GRIDCODE, select 5 classes in Natural Breaks, choose Red-Yellow-
Green ramp color and click OK.
Select the five categories shown in the window, right-click, choose Properties for Selected Symbols, set the Outline Color to No Color, and then
click OK.

Figure 6a:
Create a new map document in ArcGIS ArcMap, browse to the folder “data/raw/Safetipin/MAPDATA” in the “Catalog”, with file "52_013.shp",
"college.shp" and "student.shp".
Drop the files listed above onto the new map, creating three separate layers. Arrange the layers so that "student" and "college" are on top, and
"52_013" is the bottom layer.
Right-click on the 52_013 layer and select Properties. Go to the Symbology tab, expand the Categories, and choose Unique values. In the Value
Field, select mode and click Add All Values. For each category, double-click the symbol, change the color, and set the line width to 2. Use green for
Rickshaw, blue for Metro, orange for Walk, and purple for Bus. Next to , where it says mode, delete the text so the heading is left blank. Click OK.
Next, double-click the symbol for the student layer and change it to a blue triangle. Do the same for the college layer, changing its symbol to a
black star.
Rename the layers by right-clicking on each one, selecting Properties, going to the General tab, and updating the Layer Name. Rename 52_013 to
Travel mode, college to Chosen college, and student to Student.
Switch from Data View to Layout View in order to add the map elements. To add the legend, click Insert and then Legend, select only the Travel
mode layer, click Next, type Travel mode as the legend title, and continue clicking Next until finishing. Repeat this process for the Chosen college
and Student layers, but remove the legend title.
To add a north arrow, click Insert, select North Arrow, choose ESRI North 3, and click OK. Finally, to add a scale bar, click Insert, select Scale Bar,
choose Alternating Scale Bar 2, and click Properties. In the Scale and Units tab, set the Division Units to Kilometers. Then go to the Format tab,
change the text size to 5, click OK, and accept the changes. Change the scale bar size manually so that the minimum value is 0 and the maximum
value is 4.

Figure 6b:
Add figure 6a to figure A14b and zoom in.

Figure A1:
Create a new map document in ArcGIS ArcMap, browse to the folder “data/raw/Safetipin/ArcGIS” in the “Catalog”, with files
"coll_loc_insample_Withsize.shp", "coll_loc_shortsurvey_withsize.shp", "CollegeLocations_final_1.shp", and "Delhi_NCT_pincodes.shp."
Drop the files listed above onto the new map, creating four separate layers. Order them with "coll_loc_insample_Withsize" in the top layer and
"Delhi_NCT_pincodes" in the bottom layer.
For all layers except Delhi_NCT_pincodes, right-click on the layer and select Properties. Then, go to the Symbology tab. Expand the Quantities
option and select Graduated Symbols. In the Fields section, set the Value field to size. Adjust the ranges as needed and click OK.

Figure A14a:
Create a new map document in ArcGIS ArcMap, browse to the folder “data/raw/Safetipin/Safety data” in the “Catalog”, with file "clip_grid_500.shp"
and “data/raw/Safetipin/ArcGIS” with file "NCR_boundary_Project".
Drop the files listed above onto the new map, creating two separate layers. Order them with "clip_grid_500" in the top layer and
"NCR_boundary_Project" in the bottom layer.
Right-click on the layer on the clip_grid_500 icon and select Properties. Then, go to the Symbology tab. Expand the Quantities option and select
Graduated Colors. In the Fields section, set the Value field to GRIDCODE, select 5 classes in Natural Breaks, choose Red-Yellow-Green ramp color
and click OK.

Figure A14b:
Create a new map document in ArcGIS ArcMap, browse to the folder “data/raw/Safetipin/Safety data” in the “Catalog”, with file
"clip_grid_1500.shp" and “data/raw/Safetipin/ArcGIS” with file "NCR_boundary_Project".
Drop the files listed above onto the new map, creating two separate layers. Order them with "clip_grid_1500" in the top layer and
"NCR_boundary_Project" in the bottom layer.
Right-click on the layer on the clip_grid_1500 icon and select Properties. Then, go to the Symbology tab. Expand the Quantities option and select
Graduated Colors. In the Fields section, set the Value field to GRIDCODE, select 5 classes in Natural Breaks, choose Red-Yellow-Green ramp color
and click OK.
Select the five categories shown in the window, right-click, choose Properties for Selected Symbols, set the Outline Color to No Color, and then
click OK.

List of Exhibits
The provides code reproduces selected tables and figures in the paper, as explained and justified below.
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Figure/Table
#

Program
Line
number

Output file Note

Figure 1 11_figure_1_cdf.do 37
figure1_cdf_abs_rank.pdf,
figure1_cdf_rank_1co.pdf

Found in output/figures

Figure 2 n.a. (no data) stylized.pdf Diagram

Figure 3 12_quality_dist.do 16 figure_3a.pdf, figure_3b.pdf Found in output/figures

Figure 4 ArcGis Students_allcoll_FS_withcoll.pdf Find instructions above

Figure 5 ArcGis
SafetyAudits_pca_safres.pdf,
IDW_pcasafres.pdf

Find instructions above

Figure 6 ArcGis data_eg3_nb1.pdf, data_eg7.pdf Find instructions above

Figure 7 33_descriptive_analysis_resid_ses_quant2.do 539

safety_diff_r_1_5_main.pdf,
qual_diff_r_1_5_main.pdf,
time_diff_r_1_5_main.pdf,
cost_diff_r_1_5_main.pdf

Found in output/figures

Figure 8 13_balanced_spread.do 79
figure_8_a.pdf, figure_8_b.pdf,
figure_8_c.pdf, figure_8_d.pdf,
figure_8_e.pdf

Found in output/figures

Figure 9 15_mc_simulation_output_test.do 129 mc_simulation.pdf Found in output/figures

Table 1 16_table_1_summary_stats_updated.do 129 table_1_updated_v2.tex Found in output/tables

Table 2 17_table_2_gmap_routes_updated.do 149 gmaps_summary_updated.tex Found in output/tables

Table 3 18_table_3_travel_behavior_updated.do 111 table_3_updated.tex

Found in output/tables. The
values in the harassment
column were hardcoded in the
Stata do-file; the source of
these values is Safecity (Asok,
2016).

Table 4 19_individual_table_benchmark_noc_sf.do 326 IndividualTablebenchmark_noc_sf.tex

Found in output/tables. The
table in the paper shows
bootstrapped standard errors
in brackets. These are obtained
at the end of the code and
displayed in a matrix. The
bootstrapped errors are then
added manually.

Table 5 20_individual_table_robustness_noc_sf.do 320 IndividualTablerobust_major_noc_sf.tex Found in output/tables

Table 6 21_table_asc.do 163 individual_table_asc.tex Found in output/tables

Figure A1 ArcGis AllDU_colleges_withsize_forpaper.pdf Find instructions above

Figure A2 22_figure_A1_pdf_examscore.do 35 figure_A1_pdf_examscore.pdf Found in output/figures

Figure A3 23_figure_A_numnics.do 65 numincs_C5.pdf Found in output/figures

Figure A4 n.a. (no data)
data_eg1_nb.pdf, data_eg2_nb.pdf,
data_eg4_nb.pdf, data_eg6_nb1.pdf

Found in output/figures

Figure A5 34_crime_safety.do 107 crime_safety.pdf Found in output/figures

Figure A6 33_descriptive_analysis_resid_ses_quant2.do 671 figure_resid_radii_combined_25.pdf Found in output/figures

Figure A7 n.a. (no data) triangular_dist.pdf Triangular distribution image

Figure A8 23_figure_A_numics.do 115 value_of_college_first_co_bygender.pdf Found in output/figures

Figure A9 25_external_rankings_v1.do 95

extrank_cutoff_polsc_indiatoday.pdf,
extrank_cutoff_bcom_indiatoday.pdf,
extrank_cutoff_physics_indiatoday.pdf,
extrank_cutoff_polsc_week.pdf,
extrank_cutoff_bcom_week.pdf,
extrank_cutoff_physics_week.pdf

Found in output/figures

Figure A10 26_placement_analysis.do 167,180
placement_cutoff_avg_polsc_pres.pdf,
placement_cutoff_high_polsc_pres.pdf

Found in output/figures
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Figure/Table
#

Program
Line
number

Output file Note

Figure A11 27_balanced_spread_coed.do 126 figure_LQ_coed.pdf Found in output/figures

Figure A12 28_mrs_dist.do 119 mrs.pdf Found in output/figures

Figure A13 14_MRS_bars.do 66
mrs_sq_bars.pdf, mrs_st_bars.pdf,
mrs_sc_bars.pdf

Found in output/figures

Figure A14 ArcGis
extrapolation_500_edit.pdf,
extrapolation_1500_edit.pdf

Found in output/figures

Table B1 29_table_B1_comparing_samples.do 168 table_B1_updated.tex Found in output/tables

Table B2 30_table_nondelhi_updated.do 86 table_x_nondelhi_updated.tex Found in output/tables

Table B3 n.a. (no data) Rajdhani_cutoff_2015_eg.png
It is a scanned copy of a
sample cutoff list from a
college at DU for 2015-16.

Table B4 5_college_choice.do 223 college_choice.tex Found in output/tables

Table B5 n.a. (no data) table_sp_rubric.tex
It is a SafetiPin safety audit
rubric

Table B6 33_table_descriptive_analysis_resid_ses_quant2.do 619 table_descriptive_analysis_25.tex Found in output/tables

Table B7 31_advantage_girl.do 48 predict_adv_women.tex Found in output/tables

Table B8 35_indiividual_table_total.do 309 IndividualTable_total.tex Found in output/tables

Table B9 38_w_se.do
159,
167

w_regressions_v1.tex, w_regressions_v2.tex Found in output/tables

Table B10 36_individual_table_noc_sf.do 156

IndividualTablebenchmark_noc_sf.tex,
IndividualTable_conditional_logit_noc_sf.tex,
IndividualTable_triangular_noc_sf.tex,
IndividualTable_rest_triangular_noc_sf.tex,
IndividualTable_normal_noc_sf.tex,
IndividualTable_lognormal_noc_sf.tex

Found in output/tables. These
tables contain the MRS results,
which were manually combined
into a single table, as shown in
the paper.

Table B11 34_individual_table_benchmark_coed_only.do 175 IndividualTablebenchmark_coed_only.tex Found in output/tables

Table B12 32_num_maj_descriptives.do 29 num_majors.tex Found in output/tables

Table B13 37_inidividual_table_noc_safetyrobust.do 14 table_robustness_grid_edit_noci.tex Found in output/tables

Table C1 n.a. (no data) metro_fares.tex

Source: Delhi Metro Rail
Corporation.
http://www.delhimetrorail.com/
(last accessed: May 28, 2020)

Table C2 n.a. (no data) train_fares.tex
Source:
https://nfr.indianrailways.gov.in,
(last accessed: May 28, 2020)

Requirements

Computational Requirements

Portions of the code were reproduced on a Windows Server 2019 Standard machine with an Intel Xeon E7-4850 v4 CPU @ 2.10GHz (16 processors), 64 GB of
RAM, running Stata 18.0 MP.

Portions of the code were reproduced on a Windows 10 Enterprise machine with an Intel Xeon Gold 6132 CPU @ 2.60GHz (16 cores, 16 logical processors), 128
GB of RAM, running Matlab 2024b.

Software Requirements

Stata (code was last run with version 14)
Matlab (code was last run with Matlab R2023a)

Memory and Runtime and Storage Requirements

Approximate time needed to reproduce the analyses on a standard desktop machine:

<10 minutes
10-60 minutes
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1-2 hours
2-8 hours
8-24 hours
1-3 days
3-14 days
> 14 days

Approximate storage space needed:

< 25 MBytes
25 MB - 250 MB
250 MB - 2 GB
2 GB - 25 GB
25 GB - 250 GB
> 250 GB

Code Description
There are three main code files:

master_1.do: Main do file that runs all STATA code until do file 8_mc_simulation.do. This section cleans survey data and organizes databases for
analysis. (Takes 14 hours to run)
master_2.m: Main script that runs all Matlab code. (Takes 463 hours to run)
master_3.do: Main do file that runs all STATA code from do file 9_conditional_logit_to_csv_v1.do. (Takes 5 minutes to run)

The body of the code is organized into the \code folder as follows:

STATA

All STATA code is stored in the /stata subfolder, and the cleaned files created by them are stored in the /coded subfolder in the /data folder.

Matlab

All Matlab code is stored in the /matlab subfolder.

Inputs for Matlab

data_fem.csv
data_fem_ses.csv
data_male.csv
data_male_ses.csv
data_fem_b`i'.csv
data_male_b`i'.csv

where i = 1,...,100

data_fem_robust_major.csv
data_fem_robust_major_ses.csv
data_male_robust_major.csv
data_male_robust_major_ses.csv
data_fem_asc.csv
data_male_asc.csv
sample_`numcoll'/sample0_`j'_`i'.csv
sample_`numcoll'/sample1_`j'_`i'.csv

where numcoll in {2,5,8}, j in {100,500,900,1300,1700,2100}, i = 1,...,100

data_fem_robust_safety.csv
data_male_robust_safety.csv
data_fem_lognormal.csv
data_male_lognormal.csv
data_fem_robust_safety_grid.csv
data_male_robust_safety_grid.csv

Outputs from Matlab

mixed_logit/`prefix'_`reg'.txt
mixed_logit/`prefix'_`reg'_sq.txt
mixed_logit/`prefix'_`reg'_st.txt
mixed_logit/`prefix'_`reg'_sc.txt
mixed_logit/coefficients/estimates_`prefix'_`reg'.csv
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prefix = female, then reg

benchmark
benchmark_ses_fixed
robust_major
robust_major_ses_fixed
asc
robust_arr_rate3
robust_usage6
robust_psm_min
robust_psm_modal
robust_light
robust_open
robust_visibility
robust_crowd
robust_security
robust_path
robust_excl_transport
robust_gender_usa
robust_excl_feeling
triangular
rest_triangular
normal
lognormal
robust_coed_only
robust_grid500
robust_grid1500

prefix = male, then reg

benchmark
benchmark_ses_fixed
robust_major
robust_major_ses_fixed
asc
robust_arr_rate3
robust_usage6
robust_psm_min
robust_psm_modal
robust_light
robust_open
robust_visibility
robust_crowd
robust_security
robust_path
robust_excl_transport
robust_gender_usa
robust_excl_feeling
triangular
rest_triangular
normal
lognormal
robust_coed_only
robust_grid500
robust_grid1500

prefix = all, then reg

benchmark
benchmark_ses_fixed
robust_major
robust_major_ses_fixed
robust_coed_only

Bootstrap

bootstrap/female_`numsim'.txt
bootstrap/female_sq_`i'.txt
bootstrap/female_st_`i'.txt
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bootstrap/female_sc_`i'.txt
bootstrap/estimates_female_`i'.csv
bootstrap/male_`i'.txt
bootstrap/male_sq_`i'.txt
bootstrap/male_st_`i'.txt
bootstrap/male_sc_`i''.txt
bootstrap/estimates_male_`i'.csv

Monte Carlo

sample_`numcoll'/female_`j'_`i'.txt
sample_`numcoll'/female_sq`j'_`i'.txt
sample_`numcoll'/female_st`j'_`i'.txt
sample_`numcoll'/female_sc`j'_`i'.txt
sample_`numcoll'/estimates_female_`j'_`i'.csv
sample_`numcoll'/male_`j'_`i'.txt
sample_`numcoll'/male_sq`j'_`i'.txt
sample_`numcoll'/male_st`j'_`i'.txt
sample_`numcoll'/male_sc`j'_`i'.txt
sample_`numcoll'/estimates_male_`j'_`i'.csv
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